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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions.
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and
avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

AAWARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.
Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent

editions.
Siemens AG C79000-G8976-C233-10 Copyright © Siemens AG 2016.
Division Process Industries and Drives ® 07/2016 Subject to change All rights reserved
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Introduction 1

SIMATIC NET PC software products

Thank you for choosing a communications product from SIMATIC NET. You have bought an
innovative product that combines fast access to automation systems with simple installation
and commissioning.

Purpose of this document

This document describes how to install the SIMATIC NET PC software products on your
PG/PC.

Validity of this installation manual

Trademarks

This installation manual relates to the products on the DVD "SIMATIC NET PC Software
V14",

The installation of the software with VMware ESXi is described in sections 3 and 4, sections
5 and 6 describe the installation in Microsoft Hyper-V.

The installation of STEP 7 Professional (TIA Portal) is described on the STEP 7 data
medium.

The information in this manual regarding calling applications using the Start menu applies to
Windows 7 SP1, Windows Server 2008 R2, Windows 8.1 and Windows 10.

The following and possibly other names not identified by the registered trademark sign ® are
registered trademarks of Siemens AG:

SIMATIC NET, HARDNET, SOFTNET, CP 1612, CP 1613, CP 5612, CP 5613, CP 5614,
CP 5622

Industry Online Support

In addition to the product documentation, the comprehensive online information platform of
Siemens Industry Online Support at the following Internet address:

(http://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo2&aktprim=99&lang=
en)

Apart from news, there you will also find:
® Project information: Manuals, FAQs, downloads, application examples etc.

e Contacts, Technical Forum

SIMATIC NET PC Software V14
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Introduction

® The option submitting a support query:

(https://support.automation.siemens.com/WW/llisapi.dll?func=cslib.csinfo&lang=en&objid
=38718979&caller=view)

® Qur service offer:

Right across our products and systems, we provide numerous services that support you
in every phase of the life of your machine or system - from planning and implementation
to commissioning, through to maintenance and modernization.

You will find contact data on the Internet at the following address:
(http://www.automation.siemens.com/partner/guiwelcome.asp?lang=en)

SITRAIN - Training for Industry

The training offer includes more than 300 courses on basic topics, extended knowledge and
special knowledge as well as advanced training for individual sectors - available at more
than 130 locations. Courses can also be organized individually and held locally at your
location.

You will find detailed information on the training curriculum and how to contact our customer
consultants at the following Internet address:

(http://sitrain.automation.siemens.com/sitrainworld/?AppLang=en)

Security information

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, solutions, machines, equipment and/or networks. They are
important components in a holistic industrial security concept. With this in mind, Siemens’
products and solutions undergo continuous development. Siemens recommends strongly
that you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable
preventive action (e.g. cell protection concept) and integrate each component into a holistic,
state-of-the-art industrial security concept. Third-party products that may be in use should
also be considered. You will find more information about Industrial Security in:
http://www.siemens.com/industrialsecurity

To stay informed about product updates as they occur, sign up for a product-specific
newsletter. You will find more information about this in
https://support.industry.siemens.com/cs/ww/en/

SIMATIC NET glossary

Explanations of many of the specialist terms used in this documentation can be found in the
SIMATIC NET glossary.

You will find the SIMATIC NET glossary on the Internet at the following address:
(http://support.automation.siemens.com/\WWW/view/en/50305045)

SIMATIC NET PC Software V14
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Installation of the SIMATIC NET PC software 2
products

2.1 Requirements and notes

User experience

To install the SIMATIC NET PC software products, you need to have experience of installing
software on the operating system you are using.

To configure the communications modules, you should have experience and knowledge of
the following:

e Structure of the plant involved.
e Configuration of the plant.

You should only undertake the installation and configuration described below if you have this
knowledge.

2.1.1 Required privileges

Privileges for installation

To install the product, you require administrator privileges.

21.2 Requirements and notes relating to the software

Operating systems

The SIMATIC NET PC software products are intended for operation with Microsoft Windows
operating systems; for details, refer to the section "Technical data (Page 71)".

Update DVD for which versions?
"SIMATIC NET PC Software, V14" is an update DVD for the following software version:

e "SIMATIC NET PC Software V13 SP2" with Windows 7 SP1, Windows 8.1 (64-bit),
Windows Server 2008 R2 SP1 and Windows Server 2012 R2 and Windows 10.

The list of products on the back of the DVD case or the delivery release in our product
support gives you an overview of the products available.

SIMATIC NET PC Software V14
Installation Manual, 07/2016, C79000-G8976-C233-10 7



Installation of the SIMATIC NET PC software products

2.1 Requirements and notes

Software licenses

Screen savers

Virus scanners

Note
To run the SIMATIC NET products, you require one software license per PC and product.

Example: If you have installed the product “HARDNET IE S7" on a PC and operate three CP
1623 modules with it , you require only one software license.

Example 2: If you use SOFTNET PB S7 on a PC in three virtual machines, you require three
licenses.

Using a screen saver during operation can cause system overload.

Some screen savers do not release parts of memory again. This leads to a continuous
reduction in usable memory.

The use of a virus scanner during runtime can impair or severely slow down communication.
For this reason, dynamic virus protection in particular using gatekeeper mechanisms is not
advisable.

The following virus scanners have been tested in conjunction with the SIMATIC NET PC
software products (the default settings of the virus scanners were not changed for the test):

Virus scanner name Tested with operating system

McAfee AntiVirus Plus 2016 |« Windows 7 SP1 (32-bit and 64-bit)

o Windows 8.1 (64-bit)

e Windows 10 Pro (64-bit) as of version 1511, build 10586

e Windows 10 Enterprise (64-bit) as of version1511, build 10586

Norton Security 2016 e Windows 7 SP1 (32-bit and 64-bit)
e Windows 8.1 (64-bit)
e Windows 10 Pro (64-bit) as of version 1511, build 10586

e Windows 10 Enterprise (64-bit) as of version 1511, build 10586

SIMATIC NET PC Software V14
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Installation of the SIMATIC NET PC software products

2.1 Requirements and notes

Virus scanner name Tested with operating system

Kaspersky AntiVirus 2016 e Windows 7 SP1 (32-bit and 64-bit)

e Windows 8.1 (64-bit)

e Windows 10 Pro (64-bit) as of version 1511, build 10586

e Windows 10 Enterprise (64-bit) as of version 1511, build 10586

TrendMicro OfficeScan 10.6 |« Windows 7 SP1 (32-bit and 64-bit)

e Windows 8.1 (64-bit)

¢ Windows 10 Pro (64-bit) as of version 1511, build 10586

e Windows 10 Enterprise (64-bit) as of version1511, build 10586
¢ Windows Server 2008 R2 SP1

e Windows Server 2012 R2

Note

If you use a virus scanner, make sure that the computer has enough system resources.

Restore points

Note

¢ A system restore point is not created automatically and needs to be set as a manual
restore point prior to the installation.

21.3 Requirements and notes relating to the hardware

Note

We recommend that you first install the software and license as described in this
documentation and install the communications processors afterwards.

Bus collisions after reinstallation

With a new installation all PROFIBUS communications processors receive the bus address
0. If there are several communications processors connected to the same bus, this inevitably
leads to address conflicts.

Solution

With such a constellation, set different bus addresses for the communications processors
before attaching the communications processors to the bus. This can be done using the
"Communication Settings" application.

SIMATIC NET PC Software V14
Installation Manual, 07/2016, C79000-G8976-C233-10 9



Installation of the SIMATIC NET PC software products

2.1 Requirements and notes

Plug and play

214

Description

If the plug-and-play mechanism does not find the driver after installing the communications
processor and then rebooting the computer, you will need to start the search for drivers
manually. Follow the steps outlined below:

1. Open the Device Manager.

2. Select the top expression in the list box (the local PC) and then the menu command
"Action" > "Scan for hardware changes".

3. Confirm all the following dialogs with "Next".

Note

If a question appears in this dialog box asking whether or not you want to search for suitable
drivers on the Internet, select "No, not this time" and then click "Next".

Steps in installation

Follow the instructions below step by step to install the SIMATIC NET PC software products.

Note

If you plan to use OPC XML-DA prior to installation of the SIMATIC NET DVD read section 7
(Page 51).

Note

During the installation, you may have to restart your computer several times depending on its
configuration and the software you are installing.

These restarts are unavoidable parts of the installation process!

Following a restart on your computer, the installation will continue automatically with the next
step. You only need to follow the installation instructions in this description. No further
measures are necessary.

Note

Make sure that the same user is logged on following a restart.

Installation on an Asiatic Windows

10

The installation dialog of the "SIMATIC NET PC Software" offers you the choice of "German"
or "English". If you want to install on an Asiatic Windows platform (Chinese Korean or
Japanese), select the “English” language version.

SIMATIC NET PC Software V14
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Installation of the SIMATIC NET PC software products
2.2 Procedure

2.2 Procedure

Step 1 - Registering with the operating system

It is only possible to install SIMATIC NET PC software products if you have administrator
privileges.

You should therefore log in with the operating system using an account belonging to the
group of administrators.

Step 2 - Closing open applications

Close all active programs. This also includes all virus scanners.

Step 3 - Reading SIMATIC NET documents

Supplied information
Please read the information that ships along with the product. This is important to you
because ...

e .. it may need to be (or at least should be) taken into account during installation.
e .. it may support you when configuring the hardware.

e it will provide you with instructions on configuring your specific product that are not
contained in the "Industrial Communication for PG/PC" manual.

Descriptions of the SIMATIC NET products
The SIMATIC NET Manual Collection contains all SIMATIC NET documentation and is
supplied with the “SIMATIC NET PC Software” product.

Step 4 - Inserting the "SIMATIC NET PC Software" DVD
Insert the "SIMATIC NET PC Software" DVD and wait until the following dialog box appears:

SIMATIC NET PC Software V14
Installation Manual, 07/2016, C79000-G8976-C233-10 11



Installation of the SIMATIC NET PC software products

2.2 Procedure

SIEMENS

® Siemens AG, 1998 - 2016. All Rights Reserved.

Dizplay Beadme Inztall Software Dizplay Documents Cancel |

Note

If this dialog box does not appear at the latest after 30 seconds, the autostart function of your
computer is not activated.

In this case, start the "setup.exe" program in the main folder on the "SIMATIC NET PC
Software" DVD.

Step 5 - Reading the readme file

The readme file contains the latest information on the SIMATIC NET PC products.

Click the "Display Readme" button and read the information displayed.

Step 6 - Installing software

12

Click the "Install Software" button.

Follow the instructions in the dialog boxes to select the language you require and to accept
the license conditions.

Note

If you want to install on an Asiatic Windows platform, select English.

SIMATIC NET PC Software V14
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Installation of the SIMATIC NET PC software products

2.2 Procedure

Note

Depending on the operating system, there will be one or two dialog boxes relating to security
settings and the energy saving mode that you can confirm with the "Install Software" button if
you want the installation to be performed.

Step 7 - Selecting products

The "SIMATIC NET - Setup" dialog box appears.
The information in the figure below is an example and may differ slightly from the information

actually shown on the screen.

SIMATIC NET - Setup

Programs
Programs to be installed

27 SIMATIC NET
Cd SIMATIC NET PC Software V4.0
SIMATIC NET PC Software Doc V14.0
SOFTNET-IE RNA V14

L Automation License Manager V5.3 + 5P3

Help

Select a product to obtain information about
it.

Required: 784 MB

< Back ‘ Next = | Cancel

Description and procedure

The following table describes the programs in the list box shown above. Follow the

instructions and read the notes.

Programs to be installed

Description and procedure

Automation License Manager

You can install or uninstall license keys with the "Automation
License Manager".

SIMATIC NET PC Software

If the check box is selected, the SIMATIC NET PC software
products are all installed at once.

SIMATIC NET PC Software V14
Installation Manual, 07/2016, C79000-G8976-C233-10
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Installation of the SIMATIC NET PC software products
2.2 Procedure

Programs to be installed Description and procedure

SIMATIC NET PC Software Doc Select this check box if you want to install the documents for
installation and commissioning on your PC.

SOFTNET-IE RNA The "SOFTNET-IE RNA" software allows the integration of

PCs in redundant, parallel Ethernet structures based on the
Parallel Redundancy Protocol (PRP) functionality.

Select this check box if you want to install "SOFTNET-IE
RNA".

Note

SIMATIC NET PC software products from an already installed SIMATIC NET PC software
will be uninstalled automatically before the software products on this DVD are installed. The
configuration data is retained.

You will see a further warning on the screen immediately before the previous software
products are uninstalled.

Then click the "Next" button.

Reaction: The software installation starts. This can take some time.

Step 8 - Starting the transfer of license keys

License keys and upgrade license keys
Current license keys are required for the products of the "SIMATIC NET PC Software" DVD.
These ship with the product on a USB stick and must be transferred to your computer.

License keys

In the "SIMATIC NET - License Setup", you can decide whether or not the license keys are
transferred now during the installation (the "Automation License Manager" is then started) or
later. You start the transfer dialog with the "Transfer License Key" button.

SIMATIC NET PC Software V14
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Installation of the SIMATIC NET PC software products
2.2 Procedure

SIMATIC MET - License Setup

If pou hawe purchazed a product with licenze keys, vou can now trangfer them by
clicking the '"Transfer Licenze Fey'' button.

'ou can alzo trangfer the licenze later with the “Automation License Manager"
pragram that iz already installed. In thiz caze, close the dialog with "Next"

Tranzfer License Key Mest

Step 9 - Transferring license keys

You can manage the license keys for running SIMATIC NET programs with the "Automation
License Manager".

Note

For more detailed information on the "Automation License Manager", refer to the online help
for the program.

Transferring license keys
With SIMATIC NET PC products, follow the steps below to transfer license keys to your
computer:

Note

Before you can perform the next steps, the "Automation License Manager" must be started if
this has not already started automatically.

1. Select the data medium containing the required license key in the left-hand list
(navigation area).

2. In the right-hand list (object area), select the license keys you want to transfer.

3. Click on the menu command "License Key" > "Transfer..." > "Transfer License Key"
dialog box.

4. Select the local drive of your computer to which you want to transfer the license keys and
confirm with "OK".

Reaction: The license keys are transferred.

SIMATIC NET PC Software V14
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Installation of the SIMATIC NET PC software products

2.2 Procedure

Upgrade of older license keys
With authorizations of older SIMATIC products, you can use the upgrade function with new
"Upgrade" license keys.

Note
Upgrading license keys of the versions V6.0, V6.1, V6.2 and V6.3

If you upgrade an old license key, the upgrade must be made on a 32-bit operating system.
The upgraded license key can then be transferred to a 64-bit platform.

1. As described above, transfer the "upgrade" license key to the data medium on which the
authorization is located.

2. Select the authorization of the older SIMATIC product and use the "Upgrade" function
(menu command "License Key" > "Upgrade...").

Reaction: The authorization and the upgrade license key disappear and a current license
key appears instead.

After you have transferred all necessary license keys, close the "Automation License
Manager" program.

Reaction: The SIMATIC NET installation continues.

Step 10 - Completing the installation

After you have installed the license keys, the computer reports successful installation of the
SIMATIC NET PC products.

The computer is restarted on completion of the installation.

Note

Make sure that the same user is logged on following a restart.

If there is more than one network adapter installed on the PC, the "Communication Settings"
dialog box opens.

Note

If the Ethernet communications modules have not yet been installed, close the dialog with
"Cancel" and continue at "Step 11".
Once you have completed "Step 11", the following dialog box appears (see figure).

SIMATIC NET PC Software V14
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Installation of the SIMATIC NET PC software products

2.2 Procedure

Metwork Adapter Selection

Metwork adapter MAC IP

U= Ethernet 2 (SIMATIC Miniport CP1623 P... 00:1B:1B:10:E2:46  0.0.0.0

= SN (Desktopadapter Intel(R) Gigabit CT)  68:0%:CA:1D:B53:B4  190.170.1.108
1612 (Siemens CP1612) 08:00:06:6F:F5:A7  0.0.0.0
SEVLAN (Intel(R) 82579LM Gigabit Netwo... 00:19:99%:CC:88:49  10.116.21.108

Multicast Time to Live (TTL) Use secure communication

L =

Multicast Proxy

Allow communication with non-secure computers
(migration mode)

Here, select the communications module via which the PC will be configured and confirm
with "OK". Other parameters in this dialog box e.g. "TTL" must be accepted unchanged. For
the configuration a second PC is required on which STEP 7 is installed.

Note

To transfer a configuration with STEP 7 to a destination PC, a communications module is
required in the destination PC that can receive the configuration data.

If several Ethernet modules are displayed, select the one that is connected to the same
network and subnet asthe computer on which STEP 7 is running.

Step 11 - Installing communications modules
To install the communications modules, follow the steps below:

1. Read the installation manual or operating instructions for the communications module and
any other relevant documentation.

2. Install the communications modules as explained.

3. Restart your computer.

Step 12 - Starting configuration

After restarting the computer, you will need to log on with administrator privileges. It is
possible that the Microsoft "Found New Hardware Wizard" will appear.

You will then be asked whether or not you want to install the software automatically. Select
this option, click "Next" and close the wizard when it has completed its work with "Finish".

SIMATIC NET PC Software V14
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2.2 Procedure

Your computer now contains the SIMATIC NET communications software that still needs to
be configured.

The steps involved are described in the "Commissioning PC Stations" manual.

Installing further software components

Please read the two main sections "Installing the OPC XML DA Web Services (Page 51)"
and "SNMP service, SNMP OPC MIB compiler and profile files (Page 59)" on the installation
of optional software components.
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Installation and configuration with VMware vSphere 3

This section describes the requirements for installation as well as the installation of the
"SIMATIC NET PC Software" on the "VMware vSphere Hypervisor ESXi 5.5 Update 3"
platform and "VMware vSphere Hypervisor ESXi 6.0".

3.1 Requirements and notes

3.1.1 User experience

To install and operate the SIMATIC NET PC software products with "VMware vSphere
Hypervisor ESXi 5.5 Update 3” and "VMware vSphere Hypervisor ESXi 6.0", you require
experience of the product "VMware vSphere".

Information on "VMware vSphere" VMware (http://www.vmware.com/)

To configure the communications modules, you should have experience and knowledge of
the following:

e Structure of the plant involved
e Configuration of the plant
e "SIMATIC NET PC Software", see Further Information (Page 73)

Note

You should only undertake the installation and configuration described below if you have
this knowledge.

3.1.2 Requirements and notes relating to the software

Operation on a VMware ESXi server

The "SIMATIC NET PC Software" is suitable for operation on virtual machines with the
server operating system VMware vSphere.

Note the specific product and module releases in the following sections.

SIMATIC NET PC Software V14
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3.1 Requirements and nofes

Released guest operating systems

You will find a list with the guest operating systems compatible with the ESXi 5.5 Update 3
and ESXi 6.0 servers and that are suitable for operation as a PC station in the section
"Technical data (Page 71)".

Note
Configuration of passthrough for vSphere 5.5 Update 3 and vSphere 6.0

The PCle modules for use in Passthrough are configured via the vSphere client or vSphere
WebClient.

Note
UEFI/EFI BIOS

"SIMATIC NET PC Software" does not support installations with UEFI/EFI BIOS for servers
guest operating systems.

Notes on licenses

Note

A license must be obtained for each virtual machine (VM). If, for example, you want to
operate 5 VMs with the S7 protocol, you need to purchase the product that provides the S7
protocol functionality 5 times. The license keys then need to be installed on the VM in which
the corresponding functionality is used.

3.1.3 Requirements and notes relating to the hardware

You will find a list with the server hardware compatible with the ESXi server on the Web
page of VMware.

VMware compatibility list (http://www.vmware.com/resources/compatibility/search.php)

The requirements and restrictions for operation without virtualization also apply.
Minimum requirements of SIMATIC NET for a VM (virtual machine):

® 2.4 GHz (2 cores)

e 2 GB RAM (for 32-bit)/4 GB RAM (for 64-bit)

SIMATIC NET PC Software V14
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3.2 VMware passthrough

3.2 VMware passthrough

If the SIMATIC NET communication is exclusively via virtual networks, you can skip this

section.

Following installation, the VMware ESXi server supports only standard hardware (main
boards, processors, graphics cards, network adapters, ...) from the compatibility list of
VMware (refer to the section "Requirements and notes relating to the hardware (Page 20)").

Assuming that the server hardware supports "Intel Virtualization Technology (Intel VT) for
Directed I/O (Intel VT-d)" and this is activated in the BIOS, modules can be passed through
to the virtual machine. You can install and use these modules with the drivers of the vendor.

For this method, VMware uses the terms "direct path 1/O" or "passthrough". In the remainder
of this document, only the term "passthrough” will be used.

VM1

VM2

VM3

SIMATIC NET

Application

Windows Server
2008R2/2012R2

SIMATIC NET

[

Windows 7 32/64 Bit Windows 7 32/64 Bit
Windows 8.1 64 Bit Windows 8.1 64 Bit
A

v

vNIC

A A

v v

passthrough

“— <

v

v

SIMATIC NET CP

.
@

Terminal bus for VMs

Management
ESXi 6.0

(processor,
work memory,
hard disk)

Management bus

Automation bus

vNIC  virtual network adapter

Figure 3-1 Division of the Ethernet networks

The Figure "Division of the Ethernet Networks" shows a suggestion for dividing up the
Ethernet networks based on their tasks:

® VM1 uses a HARDNET module (e.g. CP 1623) for access to the automation network.

® VM2 is only connected to one virtual adapter on a separate virtual switch, at the same
time it shares a real adapter with the other two virtual machines.
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3.2 VMware passthrough

® VM3 uses a virtual Ethernet interface (SOFTNET IE) with a separate virtual switch for
access to the automation network.

® The management of the ESXi server also uses its own virtual switch, for example to allow
a backup to be copied in without repercussions for the system.

e The terminal bus is intended for the connection of "Remote Desktop Service".

Note

Loss of the connection to the management bus.

When replacing PCle modules, it is possible that the connection to the management network

will be lost.

Check the active network card in the console of the server and if necessary specify the
network card to be used.

3.2.1 SIMATIC NET modules released for ESXi
The following modules are released for use with the specified ESXi versions:
Module ESXi 5.5 Update 3 ESXi 6.0
IE General Yes Yes
CP 1623 Yes Yes
CP 1628 Yes (without Industrial Security function) | Yes (without Industrial Security function)
CP 5622 Yes Yes
CP 5623 Yes Yes
CP 5711 Yes Yes
3.2.2 Setting up SIMATIC NET modules for passthrough with the vSphere Client
Note
Passthrough can be configured under ESXi 5.5 Update 3 and ESXi 6.0 either with the
vSphere Client or with Sphere Web Client.
To be able to use SIMATIC NET modules for passthrough operation, the following steps are
necessary:
Step 1 - enabling Intel Virtualization Technology in the BIOS of the server
Requirement:
The server hardware supports the "Intel® Virtualization Technology (VT-d)".
You will find information as to whether your hardware supports "Intel® Virtualization
Technology (VT-d)" on the Intel website:
SIMATIC NET PC Software V14
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INTEL (http://www.intel.com).

Step 2 -configuring the module for passthrough

Follow the steps below to assign a module to a VM using passthrough:
1. Start the vSphere client.

Click on the server in the navigation tree on the left.

Click on the "Configuration" tab.

Click on "Advanced Settings" in the small "Hardware" dialog window.

o > w BN

Right-click on "Configure passthrough..." above the large dialog window if no modules
have yet been marked for passthrough mode. If modules have already been marked for
passthrough, click "Edit...".

Reaction: The "Mark devices for passthrough" dialog box opens.

6. Select one or more modules based on their device ID/vendor ID and subdevice
ID/subvendor ID.

(= Mark devices for passthrough i x|
Mark devices for passthrough: Hide Details

Dlﬂ 04:00.1 | Intel Corporation 1350 Gigabit Network Connection d

Dlﬂ 04:00.2 | Intel Corporation 1350 Gigabit Network Connection

Dlﬁ 04:00.3 | Intel Corporation 1350 Gigabit Network Connection [vmnicd]

D[ﬁ 00:1c.0 | Intel Corporation B Series/C220 Series Chipset Family PCI Express Root Port #2

|§| Dﬁ 06:00.0 | Texas Instruments XIQ2001 PCI Express-to-PCI Bridge

H DLE 07:0f.0 | Intel Corporation B2541P1 Gigabit Ethernet Controller [vmnicS]

E| D[ﬁ 00:1c.3 | Intel Corporation B Series/C220 Series Chipset Family PCI Express Root Port #4

i L.[JFE 08:00.0 | Intel Corporation 1210 Gigabit Network Connection

ED[E 00:1c.4 | Intel Corporation B Series/C220 Series Chipset Family PCI Express Root Port #5

=-[JI& 09:00.0 | PLX Technology, Inc. PEX 8624 24-lane, 6-Port PCI Express Gen 2 (5.0 GT/s) Switch [ExpressLane]

= |:|lE| 0a:01.0 | PLX Technology, Inc. PEX 8624 24-lane, 6-Port PCI Express Gen 2 (5.0 GT/s) Switch [ExpressLane]
: ]I% 0b:00.0 | Siemens AG SIMATIC NET CP 5622
B- D[EI 0a:05.0 | PLX Technology, Inc. PEX 8624 24-lane, 6-Port PCI Express Gen 2 (5.0 GT/s) Switch [ExpressLanz]
: .“% 0d:00.0 | Siemens AG SIMATIC NET CP 5623
E| |:|[EI 0a:06.0 | PLX Technology, Inc. PEX 8624 24-lane, 6-Port FCI Express Gen 2 (5.0 GT/s) Switch [ExpressLang]
. O 0e:00.0 | Siemens AG SIMATIC NET CP 5624
E| DlE‘ 0a:08.0 | PLX Technology, Inc. PEX 8624 24-lane, 6-Port PCI Express Gen 2 (5.0 GT/s) Switch [ExpressLane]
; @ 0f:00.0 | PLX Technology, Inc. PEX8112 x1 Lane PCI Express-to-PCI Bridge

: : .]]%| 10:04.0 | Freescale Semiconductor Inc SIMATIC NET CP 1613|

E| |:|[EI 0a:09.0 | PLX Technology, Inc. PEX 8624 24-lane, 6-Port PCI Express Gen 2 (5.0 GT/s) Switch [ExpressLang]

& 11:00.0 | PLX Technology, Inc. PEX8112 x1 Lane PCI Express-to-PCI Bridge

.]]% 12:04.0 | Freescale Semiconductor Inc SIMATIC NET CP 1628 —

Device Details

“% This device is running in passthrough mode

Device Name SIMATIC MET CP 1623 Vendor Name Freescale Semiconductor Inc
1D 10:04.0 Class ID B20

Device ID a5 Subdevice ID 4046

Vendor ID 1957 Subvendor ID 1104

Function il Slot 4

Bus 16

oK I Cancel Help

Figure 3-2  Selecting modules for passthrough with the vSphere Client
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3.2 VMware passthrough

3.2.3

24

7. Confirm your entries with "OK".
8. Restart the ESXi server to activate the passthrough configuration.

The following table shows the device IDs, vendor IDs, subdevice |IDs, subvendor IDs and
display names for SIMATIC NET modules:

Note

Valid as of the following builds:
ESXi 6.0 Build 2502222

ESXi 5.5 Update 3

Table 3-1 Assignment of the IDs

Module Device ID / Subdevice ID / Display name
Vendor ID Subvendor ID Passthrough configuration

CP 5622 407E/110A 407E/110A SIEMENS AG SIMATIC NET CP 5622

CP 5623 4069/ 110A 4069/ 110A SIEMENS AG SIMATIC NET CP 5623

CP 1623 0085/1957 4046/ 110A Freescale Semiconductor Inc
SIMATIC NET CP 1623

CP 1628 0084/1957 4074/ 110A Freescale Semiconductor Inc
SIMATIC NET CP 1628

Setting up SIMATIC NET modules for passthrough with the vSphere Web Client

Step 1 - enabling Intel Virtualization Technology in the BIOS of the server

Requirement:
The server hardware supports the "Intel® Virtualization Technology (VT-d)".

You will find information as to whether your hardware supports "Intel® Virtualization
Technology (VT-d)" on the Intel website:

INTEL (http://www.intel.com).

Step 2 -configuring the module for passthrough

Follow the steps below to assign a module to a VM using passthrough:
1. Start the vSphere WebClient.

2. Go to the server in the navigation tree on the left.

3. Click the "Manage > Settings > Hardware > PCI Devices" tab.

4. Click on the & symbol to edit the hardware.
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3.2 VMware passthrough

5. Select one or more modules based on their device ID/vendor ID and subdevice
ID/subvendor ID.

@ 192.168.58.29: Edit PCI Device Availability ?i M
All PCI Devices
- Q -
D Status Vendor Name Device Name ESX Name
» .
'ZE 0D:00.0 Available Siemens AG SIMATIC NET CP 5623
ZE 12:04.0 Available Freescale Semiconductor Inc SIMATIC NET CP 1628
-
{Z}ﬁ 10:04.0 Available Freescale Semiconductor Inc SIMATIC NET CP 1623
E_I}ﬁ 0E:00.0 Unavailable Siemens AG SIMATIC NET CP 5624 -
00:00.0
This device is available for VMs to use
Mame SIMATIC NET CP 5623 Vendor Name Siemens AG
Device ID 4069 Vendor ID 1104
Subdevice ID 4069 Subvendor ID 1104
Class ID 2800

Bus Location
D 0D:00.0 Slot ]
Bus D Function 1]

VMs Using This G PERF29W7B32 [h PERF29W7B64 [ PERF29WS1B64 ([ PERF29WS2008R2 [ PERF29WS2012R2

| ok || cancel

Figure 3-3  Selecting modules for passthrough with the vSphere WebClient

6. Save the entry by clicking the "OK" button.

7. Restart the ESXi server to activate the passthrough configuration.
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3.3 Installation of the SIMATIC NET PC software in a virtual machine

3.3 Installation of the SIMATIC NET PC software in a virtual machine

To reduce the number of restarts of virtual machines and the ESXi server required during
installation, follow the steps below when commissioning SIMATIC NET modules with
VMware passthrough:

1. Install the required SIMATIC NET modules in the ESXi server.
2. Start the ESXi server.

3. Select the required passthrough modules in the server settings (see section "Setting up
SIMATIC NET modules for passthrough with the vSphere Client (Page 22)").

4. Restart the ESXi server.

5. Install the "SIMATIC NET PC Software" in the required virtual machine as described in
section “Installation of the SIMATIC NET PC software products (Page 7).

6. Shut down the operating system of the virtual machine.
7. Add the relevant module in the settings of the virtual machine.

8. Restart the virtual machine.

SIMATIC NET PC Software V14
26 Installation Manual, 07/2016, C79000-G8976-C233-10



Installation and configuration with VMware vSphere
3.4 Upgrade

3.4 Upgrade

3.4.1 Upgrade procedure SIMATIC NET

The "SIMATIC NET PC Software V14" has been released for use with the following versions
VMware vSphere Hypervisor:

e ESXi 5.5 Update 3
e ESXi6.0

To upgrade from "SIMATIC NET PC Software V13 SP2” to "SIMATIC NET PC Software
V14" the ESXi server must first be updated to version 5.5 update 3 or version 6.0.

1. Run the update of the software VMware vSphere Hypervisor.

Note
Update for PCI/PCle modules

To operate SIMATIC NET modules vSphere 5.5 Update 3 is absolutely necessary.

2. Following the server upgrade, update the virtual machines. To do this, the current
VMware Tools must be installed on the virtual machines.
SIMATIC NET communication has been released for virtual machines with version "vmx-
09".

3. Then install the "SIMATIC NET PC Software V14"

3.4.2 Upgrading Hypervisor

The "SIMATIC NET PC Software V14" is released for VMware vSphere Hypervisor ESXi 5.5
Update 3 and ESXi 6.0.
Follow the steps below to upgrade your server:

1. Make sure that you do not use any PROFIBUS module in the passthrough, otherwise a
host upgrade is not allowed.

2. Update your "SIMATIC NET PC Software" to version V14
3. Shut down all virtual machines
4. Install the upgrade to VMware vSphere Hypervisor ESXi 5.5 Update 3. or ESXi 6.0.
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3.5 Notes and restrictions

3.5 Notes and restrictions

3.5.1 VMware vSphere vMotion

"vMotion" is the term used by VMware for moving virtual machines from one server to
another during operation.

vMotion is not possible if SIMATIC NET modules are used in passthrough mode in the
relevant VM.

vMotion has been released for operation of SOFTNET-IE S7 via the virtual network adapter
E1000. Note that the “Protocol timeout” must be set higher than maximum duration of the
communications interruption on the entire network.

3.5.2 Options for operating the virtual machines
The following option for operating virtual machines is released:
e Microsoft Remote Desktop connection

See also the notes in the readme of Remote Desktop and Terminal Services.

Note
Operator control restriction

A virtual machine must not be operated via more than one console at any one time.

Make sure that the connection between the Remote PC and VM is not interrupted. Otherwise
the VM can only be operated again after a fresh logon of the Remote Desktop client.

When using Remote Desktop, the connection must be established as an administrator to be
able to use the full range of functions of the "SIMATIC NET PC Software". The call from the
client uses mstsc.exe /admin.

3.5.3 Intel SR-IOV

SR-I0V stands for "Single Route 1/O Virtualization" and allows several VMs direct access to
a PCle device at the same time.

The use of SR-IOV has not been released for SIMATIC NET communication.

3.54 Configuration of the MAC address in STEP 7 projects

The MAC address of a virtual network adapter is assigned automatically by VMware. If it is
changes and the adapter involved is part of a configuration, the configuration may need to be
changed.
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virtual machines for use of SIMATIC NET

4.1

Note

To use the "SIMATIC NET PC Software" to create and manage the virtual machines, the
vSphere WebClient is required.

Configuration of the virtual Standard Switch (vSS)

For SIMATIC NET communication via SoftNet Ethernet products, a separate virtual Standard
Switch (vSS) must be used. You will find a schematic diagram in the section VMware
passthrough (Page 21), Figure 3-1 Division of the Ethernet networks.

Configuring a VMkernel port for server management tasks on this switch (vSS) is not
permitted.

Note
SIMATIC NET communication is not released for the virtual Distributed Switch (vDS).

To be able to use SIMATIC NET communication via vSS, make the following settings in the
properties of the vSwitch and the port groups.

Note

The settings can be specified separately for the vSwitch, individual port groups or individual
VMkernel ports.

Remember that the settings for the port group/VMkernel port overwrite the settings on the
vSwitch and therefore have priority.

You can open the properties as follows:

Open the vSphere Web client.

Click on the server in the navigation tree on the left.
Click on the "Configuration" tab.

Click "Network" in the small "Hardware" dialog window.

To configure the network, click "Properties..." on the right above the network.

2

In the menu on the left, select the port group for the created network (the settings can be
seen in the right-hand column, see Figure 4-1).
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4.1 Configuration of the virtual Standard Swifch (vSS)

To change the settings, click the "Edit..." button at the bottom left.
The properties dialog and the settings to be made are explained in the following sections.

F |
(%) vSwitch3 Properties L@&}

Ports i Metwork Adapters
CogOrStN | SORETY Port Group Properties
£t vSwitch ' 120Ports BT L
@ IENETA Virtual Machine Port Group | VLAN ID: Nane (0)
Effective Polidies -
Security
Promiscuous Mode: Reject
MAC Address Changes: Accept
Forged Transmits: Accept
Traffic Shaping
Average Bandwidth: --
Peak Bandwidth: -
Burst Size: --
Failover and Load Balancing
Load Balandng: Port ID
Metwork Failure Detection: Link status only
Motify Switches: Yes
Failback: Yes
Active Adapters: MNone
Standby Adapters: None
Unused Adapters: None
4 | m 3
Add... Edit... Remove
Close I Help

e

Figure 4-1 Selecting the port group in the properties of the vSwitch

411 General

The name of the port group is assigned on this page. This name is the name of the network
connection that can be selected in the "Properties of virtual machines".

The default setting for VLAN ID "None (0)" must be retained.

4.1.2 Security

30

For SIMATIC NET communication, the default settings for security must be retained.
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® Promiscuous Mode: "Reject"
e MAC Address Changes: "Accept"

® Forged Transmits: "Accept"

41.3 Traffic Shaping

The VMware function "Traffic Shaping" allows central and distributed restriction of the usable
bandwidth.

The VMware function "Traffic Shaping" has not been released for the "SIMATIC NET PC
Software".

The default setting "Disabled" must be retained for "Traffic Shaping".

41.4 NIC Teaming

The settings in the "NIC Teaming" tab allow the settings for load balancing and failover
configuration.

The default settings "Disabled" must be retained for NIC teaming.

Note

The server settings for assigning the MAC addresses must not be changed when using
SIMATIC NET communication.

This involves the assignment type and the VMware OUI value (Organizationally Unique
Identifier). The default values are as follows:

Assignment type: "VMware OUI assignment”

VMware OUI: for example "00:50:56" :xx:xx:xx
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4.2 Configuration of the virtual machine
4.21 Hardware
Note

1:1 assignment between module and VM recommended

If a module marked for passthrough is assigned to several VMs, only one of these VMs can
be started because the module can only be operated exclusively by one VM. The module
should therefore only be assigned to one VM.

1. Open the vSphere client.
2. Click on the required machine in the navigation tree on the left.

3. To edit the properties of the virtual machine, open the shortcut menu (right-click) and
select "Edit Settings".

Reaction: The "Virtual Machine Properties" window opens.
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4.2 Configuration of the virtual machine

) 2_Win7_xB6_de - Virtual Machine Properties " o o] |
Hardware |0pﬁ0n5| Resouroesl Virtual Machine Version: 8
—Memory Configuration
™ Show All Devices Add... | Remayve |
1011 GB Memary Size: 2::’ IGBj
Hardware | summary | |
BB Memo 3048 MB | Maximum recommended for best
i 4 performance: 8184 MB.
256 GB
d crus 2
! . Maximum recommended for this
g Video card Wideno card 178 B H <l guestOS: 4GB
WMCI devi Restricted
= i e &4 B Default recommended for this
& scslcontroller 0 LSI Logic SAS <l guestOS: 1GB,
i i i 32 GEH
& Hard disk1 Virtual Disk Minimum recommended for this
% CD/DVD drive 1 Jumfs/devicesfcdrom/mpx.... 16 GEL <l guest0S: 512 MB.
BP WNetwork adapterl WM Netwaork
5 GE —-
4 GE =1
2 GE
1 GB kg
512 MB =]
256 MBI
128 MBH
64 MEBH
32 MEH
16 MEH
3 ME
4 ME U
Help | oK Cancel |
A

Figure 4-2  Properties of virtual machines

4211 CPU/RAM settings

Select "Memory" on the left and configure the memory, for 32-bit systems at least 2 GB and
for 64-bit systems at least 4 GB.

Select "CPUs" and set 1 for the "Number of virtual sockets" and at least 2 for the "Number of
cores per socket".
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4.2 Configuration of the virtual machine

421.2 Assigning a PCle module marked with passthrough to a virtual machine
Follow the steps below to assign a module marked with passthrough to a virtual machine:
1. Click the "Add..." button.
Reaction:

The "Add Hardware" dialog box opens.

i) Add Hardware ) x|

Device Type
What sort of device do you wish to add to your virtual machine?

Device Type Choose the type of device you wish to add.

Select PCI/PCIe Device

Ready to Complete

(i) Serial Part — Information

& Parallel Port This device can be added to this Virtual Machine.

L Floppy Drive

PCI Device
i Ethernet Adapter
= Hard Disk
K&, 5CSI Device

Help | < Back | Mext = I Cancel

Figure 4-3  Selecting the device type

|
7

2. From the list, select the device type you want to add to the virtual machine and click
"Next".

3. In the drop-down list, select the module you want to add to the virtual machine and click
"Next".
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= Add Hardware il |

Choose PCI Device
Which of the present PCI/PCIe devices would you like to add?

Device Type Connection

Select PCI/PCIe Device
_ Spedfy the physical PCI/PCle Device to connect to:

Beady to Comolet
ready o Lompiete

IDDDD:Da:DD.D | Siemens AG SIMATIC MET CP 5623 j

Mote: The presence of a PCI/PCle device passthrough will

2 prevent the use of many commands on the virtual machine.,
It will not be able to be suspended, to have snapshots taken
or restored, or to partidpate in vMotion,

1 Adding a PCI Passthrough device to this VM will automatically
—=  setits minimum memory reservation equal to its memory size,

< Back | Next > I Cancel |

4

Figure 4-4 Selecting a module

Note

With a CP 5711, first add a USB controller

To be able to assign a CP 5711 to a virtual machine, you must first add a USB controller.
Follow the steps described below:

1. Initially select "USB controller" instead of "PCI device".

2. Start the VM and wait until the VMware device drivers for the controller are installed. You
can then shutdown the VM and continue at Step 3.

3. You can add the CP 5711 by selecting "USB device" in the "Add Hardware" dialog.

Note

A passthrough module can be operated by only one VM at any one time.

See also
Setting up SIMATIC NET modules for passthrough with the vSphere Client (Page 22)
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4.2 Configuration of the virtual machine

4213

422

4221

4222

4223

36

Adding network adapter E1000 to the virtual machine

SIMATIC NET communication has been released for the network adapters E1000, E1000E
and VMXNET 3.

The virtual network adapter VMXNET 2 has not been released.

The setting of the MAC address for SIMATIC NET communication must remain set to the
default (automatic).

When adding an Ethernet adapter, you need to select the corresponding network based on
the port group name (section "Configuration of the virtual Standard Switch (vSS) (Page 29)").

Options

The following settings relate to the advanced options in the "Options" tab.

Memory/CPU Hotplug
The settings for "Memory/CPU Hotplug" must remain set to the defaults:
e "Disable memory hot add for this virtual machine"

e "Disable CPU hot plug for this virtual machine"

Boot options

The settings for "Boot options" must remain set to "BIOS" for the specified boot firmware.

Starting a virtual machine

Once you have assigned the module marked for passthrough to a virtual machine, the
device manager of the operating system recognizes the virtual machine when the
corresponding module starts up.

If "SIMATIC NET PC software" is installed and a SIMATIC NET module is assigned, the
suitable driver will be installed automatically.

Note
1:1 assignment between module and VM recommended
If a module marked for passthrough is assigned to several VMs, only one VM can be started

because the module can only be operated exclusively by one VM. The module should
therefore only be assigned to one VM.
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This section describes the requirements for installation as well as the installation of the
"SIMATIC NET PC Software" on the "Microsoft Hyper-V" platform in the operating systems
Windows Server 2012 R2 and Windows 10.

5.1 Requirements and notes

5.1.1 User experience

To install and operate the SIMATIC NET PC software products with "Microsoft Hyper-V" you
require experience of the product "Microsoft Server 2012 R2" or "Windows 10" and
"Microsoft Hyper-V". (http://www.microsoft.com)

To configure the communications modules, you should have experience and knowledge of
the following:

e Structure of the plant involved
e Configuration of the plant
e "SIMATIC NET PC Software"

Note

You should only undertake the installation and subsequent configuration if you have this
knowledge.

5.1.2 Requirements and notes relating to the software

Operation with Hyper-V

The "SIMATIC NET PC Software" is suitable for operation on virtual machines with the
following SOFTNET IE S7 products in Hyper-V.

® SOFTNET-IE S7 (Lean, Extended)
® SOFTNET-IE S7 REDCONNECT

To operate virtual machines Hyper-V must be activated on the host operating system. To do
this in Server 2012 R2 the role "Hyper-V" must be added or in Windows 10 the option
"Hyper-V". The "SIMATIC NET PC Software V14" can be installed and used on the host
operating system. Note the specific product and module releases in the following sections.
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5.1 Requirements and nofes

Released guest operating systems

You will find a list with the guest operating systems compatible with the "Hyper-V" and that
are suitable for operation as a PC station in the section "Technical data (Page 71)".

NOTICE
SIMATIC NET PC modules are only supported on the host operating systems

The configuration of PCle modules is only possible on the host operating system. No
drivers are installed that make the modules available within the guest system.

NOTICE
Use of PROFIBUS in virtual machines

Due to the lack of USB support of the guest operating systems, PROFIBUS cannot be used
directly in Hyper-V. With routing, however, a CP 5711 (with the field PG CP 5711 Onboard)
connected to the host operating system can be used.

You will find detailed information on the Internet under the following entry ID:

100450795 (https://support.industry.siemens.com/cs/document/100450795/wie-kann-eine-
steuerung-%C3%BCber-einen-pci-bzw-pcie-angebundenen-profibus-mpi-cp-zum-laden-
aus-einer-vm-(vmware-player-workstation)-genutzt-werden?dti=0&lc=en-WW)

5.1.3 Requirements and notes relating to the hardware

The requirement is the use of compatible server hardware for the host system Windows
Server 2012 R2 or Windows 10. See also Hotspot-Text (http://www.microsoft.com) for
information on this.

The requirements and restrictions for operation without virtualization also apply.
Minimum requirements for SIMATIC NET software for a VM (virtual machine):

e CPU 2.4 GHz (min. 2 cores)

e 2 GB RAM (for 32-bit operating system )/4 GB RAM (for 64-bit operating system)

If "STEP 7 Professional (TIA Portal)" is installed as well, the requirements described in the
readme file must be taken into account.
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5.2 Installation of the "SIMATIC NET PC Software" in a virtual machine

5.2 Installation of the "SIMATIC NET PC Software" in a virtual machine

To install the "SIMATIC NET PC Software V14", follow the steps described in the section
"Installation of the SIMATIC NET PC software products (Page 7)".

5.3 Recommended configuration for the host system

The "SIMATIC NET PC Software" can also be installed on the host system. In contrast to the
guest systems of "Hyper-V", here all SIMATIC NET PC modules can be used here.

Note
Use of general Ethernet modules

The general Ethernet modules are however a special case. These can be assigned to a
virtual switch. A change of the Ethernet modules used by "SIMATIC NET PC Software" is
only permitted in offline mode. If a change needs to be made to the configuration, the
general Ethernet module must be taken out of the configured operation. Following this all
SIMATIC NET PC programs need to be exited.
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5.3 Recommended configuration for the host system

5.3.1

Configuration of the guest operating systems

SIMATIC NET communication from guest operating systems is only possible via virtual
Ethernet network cards. The following figure shows an example of the connection of guest
systems via virtual switches on communications networks as normal in an industrial
environment.

Application

Host operating system
Optional with

Windows 7 Windows 7 Windows 10 SIMATIC NET PC Software

32 Bit

64 Bit 64 Bit

Virtual switch Virtual switch

vNIC  virtual network adapter
pNIC  physical network card

Figure 5-1

40

Configuration with "SIMATIC NET PC Software"

VM1 is only connected to one virtual adapter on a separate virtual switch, at the same
time it shares a real adapter with the other two virtual machines.

VM2 uses a virtual Ethernet interface (SOFTNET IE) with a separate virtual switch to the
automation network.

VM3 also uses a virtual Ethernet interface (SOFTNET IE) with the same virtual switch to
the automation network. Make sure that the maximum bandwidth of the physical module
is not exceeded.

The host operating system can be addresses directly via the management bus and the
connection to VMs established for example via "VMConnect". A backup of VMs or the
host operating system should also be via this network connection.

The terminal bus is intended for the connection of "Remote Desktop Service".
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5.3 Recommended configuration for the host system

5.3.2 Configuration of the host system without "SOFTNET-IE RNA"

To be able to use any SIMATIC NET PC modules on the physical PC, the "SIMATIC NET
PC Software" need to be installed on the host system.

The SIMATIC NET PC modules are only available to the VMs with restrictions.

Host operating system

Windows 7 Windows 10
32 Bit 64 Bit

Virtual switch Virtual switch

_:: :: :: -

vNIC  virtual network adapter
pNIC  physical network card

Figure 5-2  Configuration without "SOFTNET-IE RNA"
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5.3 Recommended configuration for the host system

5.3.3 Configuration of the host system with "SOFTNET-IE RNA"

The host operating system in "Hyper-V" is of no special significance since it itself is a virtual
machine, it can however directly access physical and virtual Ethernet modules.

Note
Using SOFTNET IE-RNA

The use of SOFTNET IE RNA on guest systems is not possible. To use SOFTNET-IE RNA it
is however adequate to install the SOFTNET-IE RNA software on the host.

"SOFTNET-IE RNA" is a redundancy product which essentially provides cable redundancy.
It can be used by both host operating systems and guest operating systems (VMs). To use
"SOFTNET-IE RNA" it is adequate to install the product "SOFTNET-IE RNA" on the host
operating system and to configure with the intended physical network modules. To do this a

license for "SOFTNET-IE RNA" is necessary.

Windows 10
64 bit

Virtual switch

Virtual switch

vNIC  virtual network adapter
pNIC  physical network card

Figure 5-3  Configuration with "SOFTNET-IE RNA"

Host operating system
with installed
"SOFTNET-IE RNA"

When operating several VMs on a SOFTNET-IE RNA network make sure that the bandwidth
of the physical network is not exceeded. If necessary use the option of specifying the
network bandwidth on the corresponding virtual network adapter of the VM.
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5.4 Notes and restrictions

54 Notes and restrictions

5.4.1 Microsoft "Life Migration"

"Life-Migration" is the term used by Microsoft for moving virtual machines from one server to
another during operation. Life Migration is not supported by SIMATIC NET PC Software.

54.2 Options for operating the virtual machines
The following option for operating virtual machines is released:
e Microsoft Remote Desktop connection

See also the notes in the readme of "Remote Desktop" and "Terminal Services".

Note
Operator control restriction

A virtual machine must not be operated from more than one console at any one time.

Make sure that the connection between the Remote PC and VM is not interrupted. Otherwise
the VM can only be operated again after a fresh logon of the Remote Desktop client.

When using "Remote Desktop", the connection must be established as an administrator to
be able to use the full range of functions of the "SIMATIC NET PC Software". (Call on the
client: mstsc.exe /admin (as of Windows Vista) or mstsc /console (up to Windows XP))

5.4.3 "Intel SR-IOV"

"SR-IOV" stands for "Single Root I/O Virtualization" and allows several VMs direct access to
a PCle device at the same time.

The use of "SR-IOV" has not been released for SIMATIC NET communication.

54.4 Configuration of the MAC address in STEP 7 projects

The MAC address of a virtual network adapter is assigned automatically by Hyper-V. If it is
changes and the adapter involved is part of a configuration, the configuration may need to be
changed.
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5.4 Notes and restrictions
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Configuration of Hyper-V and virtual machines for

use of SIMATIC NET

6.1 Virtual hardware

As virtual hardware Microsoft make the two following versions available:

® Generation 1

® Generation 2

o MNew Virtual Machine Wizard

Before You Begin

Specify Name and Location
Spedify Generation

Assign Memory

Configure Networking
Connect Virtual Hard Disk

Installation Options

Summary

[} &I'I Specify Generation
=N

Choose the generation of this virtual machine.

() Generation 1

This virtual machine generation supports 32-bit and 64-bit guest operating systems and provides
virtual hardware which has been available in all previous versions of Hyper-Vv.

® Generation 2

This virtual machine generation provides support for newer virtualization features, has UEFI-based
firmware, and requires a supported 64-bit guest operating system.

1, Once a virtual machine has been areated, you cannot change its generation.

More about virtual machine generation support

< Previous Finish Cancel

Figure 6-1 Selection of the "Generation" of the virtual computer.

Configuration guest system with VMs of Generation 1

For the operating system Windows 7 (32-bit or 64-bit) the use of Generation 1 VMs is

necessary.

As the Ethernet module, configure the "Network Adapter" and not the "Legacy Network
Adapter" since its performance is inadequate.

Before installing the operating system assign adequate main memory and CPU resources to
the VM according to your intended use.
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Configuration of Hyper-V and virtual machines for use of SIMATIC NET

6.1 Virtual hardware

Configuration guest system with VMs of Generation 2
For the guest operating system Windows 10 the use of Generation 2 VMs is recommended.

Before installing the operating system assign adequate main memory and CPU resources to
the VM according to your intended use.
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6.2 Configuration of the virtual switch

6.2 Configuration of the virtual switch

The configuration of the virtual switch is performed by the manager for virtual switches that
can be called from the "Action" menu of the Hyper-V manager.

_éi Hyper-V Manager == O X
File Action View Help
| 7@ B
35 Hyper-V Manager Actions
== -~ Virtual Machines
&4 HYPERV-HOST : HYPERV-HOST al~
Name State CPU Usage Assig
- New »
3 vWin7x64ja Off
é vWin732en Off L Import Virtual Machine...
& vWin%32en Off | Hyper-V Settings...
[ vWin10Prox64 Off Y Virtual Switch Manager...
& Virtual SAN Manager...
@ Edit Disk...
% & Inspect Disk...
Checkpoints &i Stop Service
7S Remove Server
vWin10Prox64
() Refresh
Adapter Connection View »
Netzwerkkarte (Dynamic MAC: 00:15:5D:0A:8A:02) wvAutomationbus ﬂ Help
Netzwerkkarte (Dynamic MAC: 00:15:50:0A:8A:06) vTeminalbus
vWin10Prox64 -
=3 Connect...
g% Settings..
Summary Memory Networking . Upgrade Configuration Versio...
< 5> |©® Start -
HYPERV-HOST: 1 virtual machine selected.

Figure 6-2  User interface of the Hyper-V manager

Note

Close all SIMATIC NET PC Software programs before you make configuration changes for
virtual switches with the manager.

With the manager for virtual switches, via the "Virtual Switches" > "New virtual network
switch" menu you have the option of generating and configuring additional virtual switches.
For use with the "SIMATIC PC Software", the switch should be directly assigned a physical
Ethernet module for the automation bus. The option "Allow common use of this network
adapter for the management operating system" needs to be disabled for SIMATIC NET
communications processors. For the terminal bus this is not absolutely necessary.
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6.2 Configuration of the virtual switch
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@'_: Virtual Switch Manager for HYPERV-HOST

A Virtual Switches
A New virtual network switch
& .!‘ vAutomationbus
Intel(R) 1350 Gigabit Network ...
&= J. vPrivate
Private virtual switch

# o vTerminabus
Intel(R) 1350 Gigabit Network Con...
@ iy vIntern
Internal only
2 Global Network Settings
U MAC Address Range

00-15-5D-0A-8A-00 to 00-15-5D-0...

w'y Virtual Switch Properties

Name:

vAutomationbus

MNotes:

Switch for SIMATIC NET PC Communichtion

Connection type

What do you want to connect this virtual switch to?

(® External network:

| Intel{R) 1350 Gigabit Network Connection

[] Allow management operating system to share this network adapter

(O Internal network
) private network

[ oc |

Cancel Apply

Figure 6-3  User interface of the manager for virtual switches

SIMATIC NET PC Software V14

Installation Manual, 07/2016, C79000-G8976-C233-10




Configuration of Hyper-V and virtual machines for use of SIMATIC NET

6.3 Configuration of the virtual machine

6.3 Configuration of the virtual machine

The configuration of the virtual machine by the integrated wizard is not adequate to operate
the "SIMATIC NET PC Software". Changes are necessary.

To do this, start the "Hyper-V Manager" and open the "Settings" menu of the VM in question.

;.3 Hyper-V Manager _ O %
File Action View Help
L AR Nsollll 7 Mo
35 Hyper-V Manager Actions
== -~ Virtual Machines
& HYPERV-HOST : — | HYPERV-HOST - A
Name State CPU Usage Assig
= New »
3 vWin7x64ja Off
é vWin732en Off L Import Virtual Machine...
g vWin#A32en Off 2] Hyper-V Settings...
[ vWin10Proxé4 Off 71 Virtual Switch Manager...
& Virtual SAN Manager...
@ Edit Disk...
% & Inspect Disk...
Checkpoints (W) Stop Service
7S Remove Server
vWin10Prox64
() Refresh
Adapter Connection View »
Netzwerkkarte (Dynamic MAC: 00:15:5D:0A:8A:02)  vAutomationbus H Hep
Netzwerkkarte (Dynamic MAC: 00:15:50:0A:8A:06) vTeminalbus
vWin10Prox64 -
=3 Connect...
2% Settings...
Summary Memory Networking . Upgrade Configuration Versio...
< > |© Stat v

HYPERV-HOST: 1 virtual machine selected.

Figure 6-4  The "Settings" menu in the Hyper-V manager program

CPU/RAM settings
To change the settings for CPU and RAM, follow the steps below:

1. Increase the number of assigned CPU resources from the default setting (one processor
core) to at least two processor cores.

2. Select "Work memory" and configure the work memory.
For 32-bit operating systems select at least 2 GB and for 64-bit operating systems at
least 4 GB of guaranteed main memory.

3. If the supplied configuration software "STEP 7 Professional (TIA Portal)" is also installed
additional main memory is required, see the readme file "STEP 7 Professional (TIA
Portal)".

Adding and adapting network adapters of virtual machines.

The "Settings" dialog box of the Microsoft Hyper-V manager allows new network adapters to
be added and configured.
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6.3 Configuration of the virtual machine

Note that for SIMATIC NET communication only the synthetic network adapter is released.
The emulated network adapter (Generation 1) is not powerful enough. SIMATIC NET
communication is only possible via virtual Ethernet network cards. SIMATIC NET
communications processors cannot be linked into the VM.

| Settings for vWin10Prox64 on HYPERV-HOST = X
vWin10Prox64 ~ 4 b G
A Hardware 4 Network Adapter

“ll Add Hardware

il Frmware Specify the configuration of the network adapter or remove the network adapter.

Boot from F Virtual switch:
@ security vAutomationbus -3
% Memory WANID

5120 MB ] Enable virtual LAN identification
& [ Processor

# & sCsI Controller
& I Netzwerkkarte
s
vAutomationbus
Hardware Acceleration Bandwidth Management
Advanced Features ] Enable bandwidth management

# & Netzwerkkarte

A Management

| Name

| Integration Services
€ services offere o
% Checkpoints
: P To remove the network adapter from this virtual machine, dick Remove.
mm SMart Paging File Location
C:\ProgramData \Microsoft Remove
9 Automatic Start Action

I8) Automatic Stop Action

Cancel

Figure 6-5

Properties of network adapters for virtual machines

The default settings need to be adapted. Note the following points:

50

If several VMs are intended to access a physical module the bandwidth management
needs to be set so that the maximum bandwidth of the physical module cannot be
exceeded.

Settings such as DHCP guards and router guards can interrupt the communication.

The setting "Protected network" brings about a automatic "Life Migration" if the network is
interrupted. This happens as well if this parameter is enabled for any network card. "Life-
Migration" also causes a brief interruption of the network connection.

The “Protocol timeout” value must be set higher than maximum duration of the
communications interruption on the entire network. If it is not required, disable this
setting.

NIC teaming for use on physical PCs is not released for SIMATIC NET communication.
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Description

OPC XML-DA (Data Access) allows access to process variables over the Internet.

You will find more detailed information on OPC XML-DA in the manuals "Industrial

Communication with PG/PC" (Start menu "Start" > Siemens Automation" > "Documentation
> "Manuals" > “English" > "SIMATIC NET - Industrial Communication with PG/PC Volume 1
Basics" and "SIMATIC NET - Industrial Communication with PG/PC Volume 2 Interfaces").

OPC XML-DA can only be operated in conjunction with the "Internet Information Services"
(IIS) Windows component.

Is the "IIS" Windows component already enabled?

How you continue from here depends on whether the "Internet Information Services (11S)"
Windows component and "ASP.NET" are already enabled.

If the "Internet Information Services (IIS)" Win- then ...
dows component and "ASP.NET" are ...
e ... already activated,.. ... you can go straight to Step 5 - "Security set-

tings for OPC" and check the functionality of the
OPC XML-DA Web services.

e ... not already activated,.. ... read the following note and start the installation
Step 1 - "Enable Internet Information Services
(IIS) Windows function".

Step 1 - Enable "Internet Information Services (IIS)" Windows function

The "Internet Information Services (11S)" Windows feature is an HTTP Web server. It is
required to operate OPC XML DA Web services.

Procedure under Windows 7 SP1
Install the Internet Information Services as described below:

1. In the Control Panel, go to "Programs" > "Programs and Features" > link "Turn Windows
features on or off".

2. Open the structure "Internet Information Services (11S)"> "Web Management Tools" and
enable the option "lIS Management Console".

3. Open the tree structure "Internet Information Services (11S)"> "WWW services" >
"Application Development Features" and enable the option "ASP.NET".

4. Confirm with "OK".
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Procedure with Windows 8.1

1.

In the Control Panel, go to "Programs" > "Programs and Features" > "Turn Windows
features on or off".

Open the structure "Internet Information Services"> "Web Management Tools" and
enable the option "lIS Management Console".

Open the tree structure "Internet Information Services" > "WWW services" > "Application
Development Features" and enable the option "ASP.NET 4.5".

. Confirm with "OK".

Procedure in Windows Server 2008 R2

1.

2.
3.

Open the Server Manager and enable the role "Web server (11S)" with the required
features for the local server.

As the role service for this role, add the application development service "ASP.NET".

As the role service for this role, add the management service "lIS Management Console".

Procedure in Windows Server 2012 R2

1.

Open the Server Manager and enable the role "Web server (11S)" in the “Server roles”
menu item with all required features for the local server.

2. As the role service for this role, add the management service "lIS Management Console".

In the menu item “Role Services” open the entry “Application Development” and select
"ASP.NET 4.5".

In the menu item “Features” open the entry ".NET Framework 4.5 functions” and select
"ASP.NET 4.5".

Procedure with Windows 10

1.
2.
3.

52

Open the start menu and select the entry “Programs and Features”.
Select “Turn Windows features on or off”

Open the structure "Internet Information Services"> "Web Management Tools" and
enable the option "lIS Management Console".

Select the entry ".NET Framework 4.6 Advanced Services" so that ASP.NET4.6 and
WCF services are selected.
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Step 2 - Register ASP.NET 4.0 IIS (only in Windows 7 SP1 and Windows Server 2008 R2)
The ASP.NET IIS registration tool (Aspnet_regiis.exe) is used to register ASP.NET
applications with the Internet Information Services (lIS).

Follow the steps below to register ASP.NET 4.0:
1. Open a Windows command line window in administrator mode.
2. Change to the ASP.NET installation folder:

— 32-bit system
,cd %windir%\Microsoft. NET\Framework\v4.0.30319"

— 64-bit system
,cd %windir%\Microsoft. NET\Framework64\v4.0.30319"

3. Start registration of ASP.NET 4.0 by calling "aspnet_regiis.exe -i".
4. Wait until the call returns to the Windows command line.

5. Exit the Windows command line.

Step 3 - Configuring the OPC XML DA (local host) Web service
The OPC XML DA Web service provides process data that can be accessed over the
Internet using HTTP.
Configuration consists of the following parts:
® The address of the Web service is named.

® The connection to the installed SIMATIC NET software is established.

Procedure
Follow the steps below to configure the Web service:

1. Open the "Internet Information Services (11S) Manager" dialog box.

— In Windows 10:
Start menu > All Apps > Windows Management Programs

— With other released Windows versions
Start menu "Start" > "Control Panel" > "System and Security" > "Management".

Double click on "Internet Information Services (IIS Manager".
Reaction: The "Internet Information Services (IIS) Manager" dialog opens.

2. In the navigation area, add a new application pool under <current PC> "Application
Pools".

<current PC> > "Application Pools" > shortcut menu "Add Application Pool..."

Reaction: A new window opens.
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3. In the "Name" input box, enter the name "Classic SIMATIC.NET AppPool".
In the drop-down list boxes, enter:
— .NET Framework version: .NET Framework v4.0.30319
— Managed pipeline mode: Classic

and enable the option "Start application pool immediately".
Confirm with "OK"

Reaction: A new application pool was created.

4. In the shortcut menu of the newly created application pool "Classic SIMATIC.NET
AppPool", select the menu command "Advanced Settings...".

Reaction: A new window opens.

5. In the "Process Model" section, set the "ldentity" value of "ApplicationPoolldentity" to
"NetworkService".

6. For 64-bit systems (Windows 7 SP1 64-bit, Windows 8.1 64-bit, Windows Server 2008 R2
SP1 and Windows Server 2012 R2 and Windows 10):

In the "General" section, change the "Enable 32-bit applications" value from "False" to
"True".

Reaction: This makes it possible to load the 32-bit OPC XML DA Web service in the ISS.
Close the dialog with "OK".

7. In the navigation area of the "Internet Information Services (ISS) Manager", go to "Default
Web Site" via the <current PC> and open its substructure
<current PC> “Sites” > “Default Web Site”

8. If you find the entry "OPC.SIMATIC.NET" here, skip all other entries in these instructions
and continue at Step 4.

9. Select "Default Web Site" and open "Add Application..." in the context menu.
Reaction: A new window opens.

10.Enter the folder name of the Web service in the "Alias" box.
We recommend the name "OPC.Simatic.NET" because the supplied sample programs
can then be used unchanged.

11.Select the newly created "Classic SIMATIC.NET AppPool" application pool and confirm
with "OK".

12.In the "Physical path" box, enter the path to the directory in which the installed "SIMATIC
NET PC Software" DVD makes the data accessible.

Enter the path as follows:
"Program Files (x86)\Siemens\SIMATIC.NET\opc2\binXML"
Confirm with "OK".

13.Confirm the entries in the "Add Application" dialog with "OK".

Reaction: The created Web service is displayed with its alias in "Default Web Site".
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Step 4 - ISAPI and CGl restrictions (only in Windows 7 SP1 and Windows Server 2008 R2 SP1)

The ISAPI and CGil restrictions are request handlers with which dynamic contents can
execute on a server. These restrictions are either CGl files (.exe) or ISAPI extensions (.dll).
You can add user-defined ISAPI restrictions if the 11S configuration system allows this.

Procedure

Follow the steps below to specify the ISAPI and CGI restrictions:

1.

In the Internet Information Services (IIS) manager, go to your <current PC> in the
navigation panel.

. In the data area, double click on "ISAPI and CGI Restrictions".

Reaction: The content area shows the possible settings for "ISAPI and CGI Restrictions".

Select the entry "ASP.NET v4.0 30319" with the path
"C:\Windows\Microsoft. NET\Framework\v4.0.30319\aspnet_isapi.dll".

Select the restrictions with the "Edit..." shortcut menu.
Reaction: A new window opens.

Enable "Allow extension path option to execute" and confirm with "OK".

Note

Steps 6 to 8 are only necessary with Windows 7 SP1 64-bit and Windows Server 2008
R2, they are not necessary with Windows 7 SP1 32-bit.

Select the entry "ASP.NET v4.0 30319" with the path
"C:\Windows\Microsoft. NET\Framework64\v4.0.30319\aspnet_isapi.dil".

Select the restrictions with the "Edit..." shortcut menu.
Reaction: A new window opens.

Enable "Allow extension path option to execute" and confirm with "OK".

Step 5 - Security settings for OPC XML-DA

The Microsoft Internet Information Services (11S) make your PC accessible from the Internet.
It is therefore essential to specify suitable access permissions.
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Procedure
Follow the steps below to specify the access rights:

1.

Go to your newly created Web service (Web page) in the Internet Information Services
(IIS) Manager; in this example: "OPC.Simatic.NET".

— In Windows 10:
Start menu > All Apps > Windows Management Programs

— With other released Windows versions
Start menu "Start" > "Control Panel" > "System and Security" > "Management".

Double click on "Internet Information Services (IIS Manager".
Reaction: The "Internet Information Services (IIS) Manager" dialog opens.

Select the entry "OPC.Simatic.NET" in the navigation area.

<this PC> > "Sites" > "Default Web Site" > "OPC.Simatic.NET".
Double-click on "Authentication" in the data area.

Reaction: The content area shows the possible settings for "Authentication".

Make the settings you require for anonymous access and authenticated access.

5. Restart the IIS so that the new security settings for the OPC XML DA server are applied.

Step 6 - Security settings for OPC

Before the Internet Information Services (ISS) can access OPC data, they must be given
access permissions to specific OPC services.

Procedure

Follow the steps below to obtain access rights:

1.

Start the "Communication Settings" configuration program.

Start menu "Start" > "All Programs" > "Siemens Automation" > "SIMATIC" > "SIMATIC
NET" > "Communication Settings".

Go to "SIMATIC NET Configuration" > "OPC Settings" > "Security" in the tree structure
and enable "Remote basic communication and OPC communication" by clicking the
"Release..." button.

Note

By enabling OPC security, additional security settings necessary for OPC communication
are made. These are described in the online help of the "Security" configuration dialog.

This completes installation and configuration of the software components for operating OPC
XML DA.

The next steps involve checking that everything works correctly.
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Step 7 - Displaying your Web page in the Internet Explorer or in Edge (as of Windows 10)
You can display the new Web page with the Internet Explorer:

Type in the following URL in the Internet Explorer (assuming your Web service has the name
"OPC.Simatic.NET"):

Installation was successful when the possible OPC XML DA function calls (Read, Write ...)
are displayed (see figure):

OPCXML_DataAccess Web Service - Windows
g http//locath... v | & %2 | X §O 8ing R
< Favorites @ OPCXML_DataAccess W... — fa - v »‘
OF DataAcce |

The following operations are supported. For a formal definition, please
review the Service Description.

¢ Browse

¢ GetProperties

11}

* GetStatus

+ Read l

¢ Subscribe

e SubscriptionCancel

¢ SubscriptionPolledRefresh |
o Write l

< | i v I
€ Internet | Protected Mode: On A~ ®10% ~

Figure 7-1  Web page for OPC XML DA
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Step 8 - Using the sample program for the OPC XML DA interface

58

Note

You will find the sample client program in the folder:
"Program Files (x86)\Siemens\SIMATIC.NET\opc2\samples\xml\sync\opcxml_da_sync.exe"

Requirements
Follow the steps below before you use the sample program:

1. Activate the demo mode for the S7 communication protocol as described in the "Industrial
Communication for PG/PC" manual.

2. After starting the sample program, enter the following address in the "Input the URL" box
assuming your Web service (Web page) has the name "OPC.Simatic.NET”:
http://localhost/OPC.Simatic.NET/sopcweb.asmx

OPC XML-DA Synchron Sample C# lﬁl

OPC XML-DA-\Web-Service

Input the URL:

g LRl 1O | aliC. INE A0 O

ltem0 = S7:[DEMOIM/
Value Quality/\rite Result  Time Stamp
Read Value | |f | |
Wirite Value 0 | |

Stop Sample (c) Siemens AG 2004-2011

L >

Figure 7-2  User interface of the sample program

SIMATIC NET PC Software V14
Installation Manual, 07/2016, C79000-G8976-C233-10



files

8.1

Purpose

Introduction

Requirement

SNMP service, SNMP OPC MIB compiler and profile 8

Installing the SNMP service

The SNMP OPC Server requires the SNMP service in the operating system. Full use of the
SNMP OPC Server is only possible if this Windows component is installed / enabled.

Following standard installation of Windows, the full SNMP service is not yet available in the
operating system. Without taking further steps, you can query items but cannot use SNMP
traps.

Installing the SNMP service involves the following steps:
® |nstalling the SNMP service

e Adapting the network security settings to your own security needs

You must be logged on as administrator or as a member of the administrators' group to be
able to perform the installation.

Note

If programs already use the OPC server and the SNMP service was installed while an OPC
Server was active, all programs that use the OPC Server must be closed and restarted. The
OPC server must also be shut down with "Communication Settings" > "Exit OPC Server" and
then restarted.

Note

If the computer is connected to a network, the general network settings may prevent
installation of the SNMP services.
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8.1 Installing the SNMP service

Step 1 - Installing the SNMP service

Procedure with Windows 7 SP1, Windows 8.1 and Windows 10
Install the SNMP service as described below:

1. In the Control Panel, go to "Programs" > "Programs and Features" > link "Turn Windows
features on or off".

Reaction: The dialog box with the tree structure of the installed Windows features opens.

2. Enable the "Simple Network Management Protocol (SNMP)" check box in the "Windows
Features" list and confirm with "OK".

Note
Exit OPC server

If the SNMP service was installed on an OPC server that is already active, the OPC server
must be shut down.

Shut down the OPC server with "Communication Settings" > "Exit OPC server" to ensure
that the settings are adopted. With the next request, it will start up again automatically.

Note

The SNMP service starts automatically whenever you restart the system.

Procedure with Windows Server 2008 R2 and Windows Server 2012 R2

For the local server, add the "SNMP service" feature.

Note
Exit OPC server

If the SNMP service was installed on an OPC server that is already active, the OPC server
must be shut down.

Close the OPC server with "Communication Settings" > "Exit OPC server" to ensure that the
settings are adopted. With the next request, it will start up again automatically.

Note

The SNMP service starts automatically whenever you restart the system.
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8.2 SNMP OPC MIB compiler and profile files

Step 2 - Adapting the network security settings to your own security requirements

When you install the SNMP service, not only the SNMP protocol but also an SNMP agent is
installed.

Note

Adapt the network security settings and the access permissions of the SNMP agent to your
own security needs. You will find more detailed information in our manual "Commissioning
PC Stations".

In the Control Panel, go to "System and Security" > "Administration" > "Services" entry >
"Services" dialog, "SNMP Trap" entry > right-click on "Properties" > "Security" tab.

8.2 SNMP OPC MIB compiler and profile files

MIB compiler of STEP 7

The range of information that can be monitored by the devices with the SIMATIC NET SNMP
OPC server depends on the particular device profile. With the integrated MIB compiler of
STEP 7, existing profiles can be modified and new device profiles created for any SNMP-
compliant device. It requires MIB files according to the SMIv1 standard.

MIB files for CP 1613 A2, CP 1623 and CP 1628
Suitable MIB files ship with STEP 7.

When you enter the required device in the plant configuration, the "device profile" parameter
offers you the profiles with the name of the module, for example "CP1623_V10.txt" and they
can be selected here.

The following MIB files are supported for the CP 1613 A2:
e rfc1213.mib
e automationSystem.mib

e automationTime.mib

The following MIB files are supported for the CP 1623 and CP 1628:
® rfc1213.mib

® automationSystem.mib

® automationPS.mib

e automationTime.mib
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8.2 SNMP OPC MIB compiler and profile files
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Uninstalling the SIMATIC NET PC software products 9

Note

After uninstalling the SIMATIC NET PC software products, any CP installed in the PC will no
longer work because the device driver is also uninstalled.

This is indicated in the device manager by a yellow exclamation point.
You can remedy this situation by reinstalling the "SIMATIC NET PC Software" DVD.
SOFTNET modules can also be operated with other SIMATIC products (e.g. STEP 7).

Procedure with Windows 7
To uninstall SIMATIC NET PC software products, follow the steps outlined below:
1. Go to "Programs and Features"
Start menu "Start" > "Control Panel" > "Programs" > "Uninstall Program" link.

2. Select the entry "SIMATIC NET PC Software" or "SOFTNET-IE RNA" and start to
uninstall.

Reaction: The SIMATIC NET PC software products are deleted from the hard disk.

The license keys can be uninstalled, if you require, using the "Automation License
Manager" or you can leave them on the hard disk.

3. If there are no further SIMATIC programs on your computer that require licenses, select
the "Automation License Manager" and start to uninstall the licenses.

Note

Any licenses left on the computer can no longer be backed up without the "Automation
License Manager".

Procedure for Windows 8.1 and Windows 10
To uninstall SIMATIC NET PC software products, follow the steps outlined below:
1. Open the Start menu by clicking on the corresponding button in the taskbar.

2. Select the "Control Panel" menu item. A window with the various configuration options
opens.

3. Open the "Uninstall" entry by double-clicking. A dialog box with a list of installed software
is displayed.
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4. Select the "SIMATIC NET software" entry and in the shortcut menu select the entry
"Uninstall".

5. Confirm your intention to uninstall in a dialog box. Following this, uninstallation is
performed. The license keys can be uninstalled, if you require, using the "Automation
License Manager" or you can leave them on the hard disk.

Note

Any licenses left on the computer can no longer be backed up without the "Automation
License Manager".
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Automated installation 1

10.1 Purpose and general description

Use in enterprises

Enterprises that install plants with large numbers of computers generally want to use the
same installation everywhere. Automated installation provides this option. The settings are
made with a control file.

Sequence

Installation only requires a few user decisions that generally need to be taken at the end of
the installation.

Control file

The control file is generated during a sample run and is structured like an INI file.
Itis clear to read as an ASCII file and in exceptional cases can be corrected manually.
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10.2 Structure of the control file

10.2

Description

[General] area

Structure of the control file

The control file has the name "Ra_Auto.ini" and has the following structure:

[BUNDLEINFO]

CreatedWith=SIMATIC NET PC Software

RaSetupVersion=

[GENERAL]

AutoReboot=True
RebootOnEnd=True
Setuplanguage=en

IdName=

IdCompany=

IdNumber=
LicenseKeyDestinationDrive=C:
TransferLicenseManagerKey=False
InstallLanguage=de;en
OnlyUpdateInstallation=False
[DIALOGS]
DialogLicenselList=False
DialogDone=True

[PRODUCTCODE1]
DestinationDrive=C:
Selected=True

DestinationPath=[ProgramFilesFolder] STEMENS\SIMATIC.NET

If necessary, the following parameters can be adapted, the other parameters should not be

changed

General settings are made in the [General] area.

Parameters Value range Description

AutoReboot True/false Automatic restart at the end

RebootOnEnd True/false Display of restart prompt

Setuplanguage de=German Installed language
en=English
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[Dialogs] area

10.2 Structure of the control file

The display of dialog boxes can be influenced in the [Dialogs] section.

Parameters

Value range

Description

DialogDone

True/false

Display of the closing dialog

[PRODUCTCODE1] area

The [Productcode1] area contains the product code as a title and the three following
parameters. Examples of product codes are: [LICENSEMANAGER] or [SIMNETPC].

Parameters Value range Description
DestinationDrive - Installation drive, e.g. "C:\"
Selected True/false Product selection

DestinationPath

Installation path

The installation path can be changed dynamically

by a placeholder.
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10.3 Generating the control file aufomatically

10.3 Generating the control file automatically

Description

The control file is generated by the setup program by making a trial installation and can then
be used to control the installation program.

The setup program can be called by a batch file.

Note

The configuration of the computer on which you create "Ra_Auto.ini” must correspond to the
configuration of the target computer.

If, for example, the “Microsoft Visual C++ 2012 Redistributable" is already installed on the
receiving computer, the corresponding package in the "Ra_Auto.ini" will be considered
unnecessary:

[VCREDIST2012]
Selected=False

This would have the effect, that the package would not be installed on all target computers
and the product could not be installed successfully.

Example of a batch file
The batch file shown here generates the control file "Ra-Auto.ini".
Create a batch file with the following content:
In 32-bit Windows

cd \sw\x86
setup.exe /record

In 64-bit Windows

cd \sw\x64
setup.exe /record

Copy your batch file to the root directory of the SIMATIC NET DVD. Change to this directory
and start your batch file from there.

Following this, a screen is displayed in which other settings can be made.
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10.3 Generating the control file aufomatically

The lines of the batch file example have the following significance:

Line Meaning
1 The program changes to the "x86" or "x64" folder.
2 The program starts the manual test installation and generates the con-

trol file "Ra_Auto.ini" with the "/record" parameter.
All user actions in the dialogs are stored there.

The record action stops after the "component selection" and closes the
program.

Note

During the automatic installation, note that the path for the "Ra_Auto.ini" file can be set with
the following instruction:

In 32-bit Windows

sw\x86\setup.exe /silent=<Dr>:\<folder>\Ra Auto.ini

In 64-bit Windows

sw\x64\setup.exe /silent=<Dr>:\<folder>\Ra Auto.ini
Unless a path is specified, the Windows directory is searched.

If additional questions arise or error messages are displayed during installation, a suitable
dialog opens.
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10.3 Generating the control file aufomatically
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Technical data

The "SIMATIC NET PC Software V14" DVD can be used with the following operating

systems:
Operating system * Minimum requirements
Windows 7 SP1 Professional 32-bit 2.4 GHz PCs with 2 GB RAM, 2 cores

Windows 7 SP1 Ultimate 32-bit
Windows 7 SP1 Enterprise 32-bit

Windows 7 SP1 Professional 64-bit 2.4 GHz PCs with 4 GB RAM, 2 cores
Windows 7 SP1 Ultimate 64-bit
Windows 7 SP1 Enterprise 64-bit

Windows 8.1 Pro 64-bit 2.4 GHz PCs with 4 GB RAM, 2 cores
Windows 8.1 Enterprise 64-bit

Windows 10 Pro 64-bi) as of version 1511, build 10586.218 | 2.4 GHz PCs with 4 GB RAM, 2 cores
Windows 10 Enterprise 64-bit, s of V1511, build 10586.218

Note
Windows 10 64-bit in VM only with ESXi 6.0

Windows Server 2008 R2 SP1 (Standard and Enterprise 2.4 GHz PCs with 4 GB RAM, 2 cores
Edition)
Windows Server 2012 R2 (Standard and Enterprise Edition)

*Use of VMware ESXi V5.5 Update 3 and VMware ESXi 6.0" see section "Installation and
configuration with VMware vSphere (Page 19)" Use of Microsoft Hyper-V see section
"Installation and configuration in Microsoft Hyper-V (Page 37)".

You will find further information on multi-language versions for the supported operating
systems in the readme file on the “SIMATIC NET PC Software” DVD.

For more detailed information on the minimum requirements for the PC, also refer to the
readme file on the "SIMATIC NET PC Software" DVD.
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Further Information 1 2

12.1 Documentation guide

Readme file of the SIMATIC NET products

All the important information relating to the SIMATIC NET products and other information on
configuration and operation can be found in the two readme files for the overall product
(main directory of the product DVD).

Quick Start for SIMATIC NET products

You will find a quick start for configuration in the "Commissioning PC Stations" manual if you
have installed the documentation (Start menu "Start" > “Siemens Automation” >
“Documentation” > “Manuals” > “English” > "Commissioning PC Stations").

Commissioning PC Stations

The “Commissioning PC Stations” manual contains overview information on all PC
configuration programs (“Start” menu > "Siemens Automation" > "Documentation” >
"Manuals" > “English" > “Commissioning PC Stations"),

The "Commissioning PC Stations" manual is a PDF document and can be read and printed
out when required with the Acrobat Reader.

"Communication Settings" configuration program

Here, you will find information relating to a variety of topics, for example procedures manuals
for the project engineering and configuration of connections.
("Communication Settings" folder > "help" > "SIMATIC NET Configuration™)

Manual Collection

The SIMATIC NET Manual Collection contains all SIMATIC NET documentation and is
supplied with the “SIMATIC NET PC Software” product.
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12.2 Other documents

12.2 Other documents

Supplied documents and information

Documents and information on SIMATIC NET products are available on the accompanying
DVD. The most important documents are:

e The "Readme.htm" file with the latest information on each product (in the main directory
of the DVD).

® Any printed leaflets accompanying a product

Following installation, the following documents are available:
e SIMATIC NET - Commissioning PC Stations

e SIMATIC NET - Industrial Communication with PG/PC

You can also obtain information in the integrated online help systems using the F1 key.

Additional Information on the Internet

Along with a wide range of other information, you can also obtain documentation on the
product from the Internet:

(http://support.automation.siemens.com/WWW/view/en/)> Manuals > Operating Instructions

Other product-related Internet addresses include:
e Siemens AG, Process Industries and Drives, SIMATIC NET
(http://www.siemens.com/net (http://www.siemens.com/net))

e SIMATIC NET catalog "IK PI"
(http://w3app.siemens.com/sc-static/catalogs/catalog/IK_PI_2015_de.pdf)

12.3 Technical support, contacts and training

You will find information on this in the file "TechnicalSupport.pdf" in the "\doc" folder of the
"SIMATIC NET PC Software" DVD.
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